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Can	you	highlight	duplicates	in	google	sheets.	In	google	sheets	how	to	highlight	duplicates.	Highlight	duplicates	in	google	sheets	formula.	How	to	highlight	cells	with	duplicate	values	in	google	sheets.	Highlight	all	duplicate	values	in	google	sheets.

Many	users	utilize	Google	Sheets	to	set	up	data	tables.	Large	tables	set	up	in	Google’s	spreadsheet	app	will	sometimes	include	duplicate	numerical	or	text	data	within	columns	and	rows.	Manually	looking	for	duplicated	data	to	remove	within	large	data	tables	can	be	a	slow	and	tedious	affair.	To	identify	duplicated	data	within	a	Google	Sheets
spreadsheet	quicker,	we	need	a	way	to	highlight	it.	Yet,	Sheets	doesn’t	include	any	built-in	tool	for	highlighting	duplicates.	Nevertheless,	you	can	still	highlight	duplicates	in	Google	Sheets	with	custom	formulas	and	a	Power	Tools	add-on,	as	outlined	in	the	methods	below.	How	to	Highlight	Duplicate	Column	and	Row	Data	Google	Sheets,	like	other
spreadsheet	applications,	has	a	conditional	formatting	feature.	Conditional	formatting	is	a	tool	that	enables	users	to	apply	spreadsheet	formatting	based	on	specific	cell	conditions.	For	example,	you	can	configure	a	range	of	spreadsheet	cells	to	turn	red	when	they	include	values	below	zero	by	applying	conditional	formatting.	We	can	utilize	the
conditional	formatting	tool	in	Sheets	to	apply	a	different	color	to	all	cells	within	columns	or	rows	that	include	duplicates.	However,	not	one	of	the	format	rules	in	Sheets’	conditional	formatting	utility	is	suitable	for	highlighting	duplicated	data.	Therefore,	you’ll	need	to	set	up	a	formatting	condition	based	on	a	custom	COUNTIF	formula	to	highlight
duplicates	in	Google	Sheets	as	follows.	First,	open	a	blank	Google	Sheets	spreadsheet	in	which	you	can	enter	some	dummy	data	to	apply	the	conditional	formatting.	Then	enter	the	values	444,	333,	444,	and	222	in	spreadsheet	cells	B2	to	B5,	as	shown	in	the	screenshot	directly	below.	That	data	range	includes	one	duplicated	value	(444)	to	highlight	in
Sheets.	Select	the	whole	B	column	by	clicking	B	at	the	top	of	it.	Then	click	Format	>	Conditional	Formatting	in	Sheets.	Click	the	Format	cells	if	drop-down	menu	to	select	the	Custom	formula	is	option.	Input	=COUNTIF(B:B,B1)>1	within	the	Value	or	formula	box.	Click	the	Fill	color	option	to	open	a	palette.	Select	a	color	to	highlight	duplicates	in
Google	Sheets	from	the	palette.	Press	the	Done	button	to	finish.	Now	the	duplicate	444	values	in	column	B	will	be	highlighted	with	whatever	color	you	chose	as	in	the	snapshot	directly	below.	Go	ahead	and	enter	more	duplicate	values	within	that	column.	The	conditional	formatting	will	highlight	all	cells	that	include	duplicated	numbers	or	text.	The
custom	COUNTIF	formula	entered	applies	highlights	all	values	that	are	duplicated	at	least	once	in	column	B.	You	can	configure	that	formula	to	highlight	values	that	are	duplicated	at	least	two,	three,	four,	or	more	times.	For	example,	a	=COUNTIF(B:B,B1)>2	will	only	highlight	duplicated	values	in	two	or	more	cells	(three	including	the	original	cell).
To	alter	the	formula:	Select	the	B	column	again	and	open	the	conditional	formatting	tool.	Select	the	format	rule.	Change	the	number	at	the	end	of	the	COUNTIF	formula,	and	click	the	Done	button.	You	can	apply	the	same	conditional	formatting	for	duplicates	in	spreadsheet	rows	much	the	same.	However,	you’ll	need	to	modify	the	references	in	the
formula	to	specify	a	row	and	the	first	cell	within	it.	For	example,	the	same	formula	for	row	two	would	be	this:	=COUNTIF(2:2,A2)>1.	In	that	formula,	2:2	is	the	row,	and	A2	is	the	first	cell.	How	to	Highlight	Duplicated	Data	Across	Multiple	Columns	The	above	COUNTIF	formula	will	find	duplicates	within	single	rows	or	columns.	However,	what	if	you
want	to	highlight	duplicates	across	multiple	columns?	You	could	apply	the	same	formula	above	to	each	of	the	different	columns.	However,	you	can	apply	one	COUNTIF	function	to	multiple	columns	like	this.	Open	a	blank	spreadsheet	in	Sheets.	Enter	the	dummy	data	333	and	222	in	cells	A1	and	A2.	Input	444	and	333	in	B1	and	B2.	Then	the	Sheets
spreadsheet	should	look	like	the	one	directly	below.	Select	the	cell	range	you	entered	the	numbers	in.	Hold	the	Ctrl	key	to	select	columns	A	and	B.	Click	File	to	select	the	Conditional	formatting	option.	Input	the	=COUNTIF($A$1:$C$10,A1)>1	within	the	formula	text	box.	Choose	a	color	for	the	formatting	by	clicking	the	Fill	color	option.	Select	Done	to
apply.	Now	you’ll	see	the	duplicated	333	value	highlighted	in	two	different	columns.	The	same	conditional	formatting	applies	to	all	cells	within	columns	A	and	B.	You	can	also	select	to	apply	the	same	formula	to	more	columns.	Power	Tools	is	a	freely	available	Google	Sheets	extension	that	provides	an	alternative	way	to	highlight	duplicate	data.	That
extension	incorporates	nine	alternative	spreadsheet	tools,	among	which	is	a	DeDupe	and	Compare	utility.	This	is	how	you	can	both	highlight	and	remove	duplicates	in	Google	Sheets	with	DeDupe	and	Compare.	Open	the	Power	Tools	webpage	Click	Install	on	that	page.	Select	Continue	to	confirm.	Then	you’ll	need	to	select	your	Google	Account.	Press
the	Allow	button	to	permit	Power	Tools	access.	Click	Done	to	close	the	install	message.	Open	Google	Sheets	and	a	spreadsheet	that	includes	some	duplicate	data.	Click	the	Extensions	menu.	Select	Power	Tools	>	Start	to	open	the	extension.	Click	Deduce	&	Compare	in	the	Power	Tools	sidebar.	Select	Remove	duplicate	cells	to	bring	up	the	tool	shown
directly	below.	Click	the	grid	button	on	the	right	of	the	Select	the	range	box.	Then	drag	the	cursor	over	a	cell	range	to	select	it,	and	click	the	OK	option.	Select	Next	to	view	the	options	below.	You	can	select	either	the	Duplicates	or	Duplicates	+	1	occurrences	option,	depending	on	preference.	The	Duplicates	+	1	occurrences	option	will	highlight	all
the	cells	that	include	the	duplicated	data.	Click	Next	again.	Select	the	Fill	with	color	option	on	step	three.	Choose	a	color	to	highlight	the	cells	from	the	drop-down	menu.	Press	the	Finish	button	to	highlight	all	duplicates	within	your	selected	cell	range.	You	can	select	a	Clear	values	option	instead	of	Fill	with	color	on	step	three	within	the	Find
duplicate	or	unique	cells	wizard.	Doing	so	will	save	you	manually	deleting	highlighted	duplicates.	However,	select	the	Duplicates	option	if	you	don’t	want	the	first	data	occurrence	erased.	The	Deduce	&	Compare	tool	also	includes	a	Remove	duplicate	row	wizard.	That	wizard	enables	you	to	highlight	duplicate	rows	within	spreadsheets	much	the	same.
Or	you	can	select	to	erase	duplicated	rows	with	the	Remove	duplicate	row	wizard.	Find	Duplicates	in	Google	Sheets	by	Highlighting	Them	You	can	identify	duplicated	data	in	your	Google	Sheets	spreadsheets	quicker	by	highlighting	them	with	conditional	formatting	or	Power	Tools.	It	might	be	a	bit	quicker	and	more	straightforward	to	highlight
duplicated	data	with	the	Power	Tools	method.	However,	applying	highlights	with	the	COUNTIF	formula	is	a	more	flexible	method	with	a	wider	variety	of	conditional	formatting	options	available.	If	you	work	regularly	in	spreadsheets,	transferring	various	data	from	one	cell	to	another,	you	have	probably	ended	up	with	duplicate	data	across	columns
and/or	rows.	If	your	cells	contain	formulae,	then	it	is	also	likely	that	this	duplicate	content	has	negatively	affected	your	calculations.	As	a	result,	your	data	is	no	longer	accurate,	and	it	can	become	extremely	time-consuming	to	manually	highlight	and	remove	each	duplicate	value.	This	article	will	explain	how	to	highlight	duplicates	in	Google	Sheets
using	the	built-in	conditional	formatting	feature	as	well	as	the	=UNIQUE	formula.	You’ll	then	learn	how	to	safely	remove	duplicates	from	any	range	in	your	dataset,	whether	they	appear	in	one	or	two	columns.	The	quickest	way	to	identify	duplicates	in	Google	Sheets	is	to	color	highlight	them.	You	can	perform	a	search	for	duplicates	in	one	or	two
columns	by	using	the	Conditional	Formatting	feature;	this	will	allow	you	to	color	format	the	cell	or	the	text	of	the	duplicate	content.	Let’s	start	by	finding	duplicates	in	one	column.	1.	Open	your	Google	Sheets	and	select	the	column	where	you	want	to	perform	the	search	for	duplicates.	Don’t	forget	that	your	columns	need	to	be	named	in	order	for	this
feature	to	work.	Here,	I’ll	select	Column	A	to	find	possible	duplicate	values	of	names.	How	to	Highlight	Duplicates	in	Google	Sheets	-	Select	column	2.	Go	to	Format	>	Conditional	Formatting.	The	“Conditional	Formatting”	will	open	to	the	right-hand	side	of	your	screen.	How	to	Highlight	Duplicates	in	Google	Sheets	-	Conditional	formatting	3.	Check
that	the	cell	range	shown	corresponds	to	the	column	where	you	want	to	find	duplicates.	Then	in	the	“Format	cells	if”	drop-down	list,	select	“Custom	formula	is”.	A	new	field	should	now	appear	below.	How	to	Highlight	Duplicates	in	Google	Sheets	-	Custom	formula	4.	Enter	the	following	formula	in	the	new	field,	including	the	column	range	you	selected
previously.	Here,	I	will	enter	=COUNTIF(A:A,A1)>1	How	to	Highlight	Duplicates	in	Google	Sheets	-	COUNTIF	formula	5.	In	“Formatting	style”	select	a	filling	color	for	the	duplicate	cells.	In	this	example,	I	will	select	“Red”.	How	to	Highlight	Duplicates	in	Google	Sheets	-	Formatting	style	6.	Another	way	to	format	the	duplicate	cell	is	to	change	the
color	of	the	text	color;	select	the	text	color	icon	(A)	in	the	menu	bar.	In	this	example,	I	will	select	“Red”.	How	to	Highlight	Duplicates	in	Google	Sheets	-	Text	color	7.	To	apply	the	conditional	formatting,	click	“Done”.	It	should	now	highlight	all	duplicates	using	your	formatting.	How	to	Highlight	Duplicates	in	Google	Sheets	-	Done	Google	Sheet	allows
you	to	make	data	more	readable	by	changing	the	color	of	cells	based	on	their	value.	Here's	how	to	use	conditional	formatting	in	Google	Sheets.	READ	MORE	As	you	can	see	above,	the	Conditional	Formatting	feature	has	successfully	highlighted	duplicate	values	in	one	column.	Let’s	now	apply	this	same	highlighting	method	to	duplicate	values	in	two
columns.How	to	find	duplicates	in	Google	Sheets	in	two	columns?	Finding	duplicates	in	Google	Sheets	in	two	columns	is	an	almost	identical	process;	the	only	difference	is	in	the	first	step,	where	you	need	to	select	a	larger	range	to	include	a	second	or	third	column.	This	is	especially	useful	when	your	dataset	is	too	large	for	you	to	remember	where
duplicates	may	have	occurred.	We	recommend	selecting	the	whole	sheet.	This	is	how	you	can	find	duplicates	by	applying	conditional	formatting	to	two	columns.1.	Select	the	columns	where	you	want	to	perform	the	search	for	duplicates.	Here,	I’ll	select	Column	A	and	B	to	find	possible	duplicate	values	for	both	first	names	and	last	names.	How	to
Highlight	Duplicates	in	Google	Sheets	-	Select	columns	2.	Go	to	Format	>	Conditional	Formatting.	The	“Conditional	Formatting”	will	open	to	the	right.	How	to	Highlight	Duplicates	in	Google	Sheets	-	Conditional	formatting	3.	Check	that	the	cell	range	shown	corresponds	to	the	two	columns.	Then	in	the	“Format	cells	if”	drop-down	list,	select	“Custom
formula	is”.	A	new	field	should	now	appear	below.	How	to	Highlight	Duplicates	in	Google	Sheets	-	Custom	formula	is	4.	Enter	the	same	formula	as	before,	including	the	range	you	selected.	Here,	I	will	enter	=COUNTIF(A:B,A1)>1.	As	you	can	see,	it’s	almost	the	same	formula	as	the	previous	example.	Simply	change	the	data	range	of	the	first
parameter	to	the	range	of	columns	you	want	to	check.	How	to	Highlight	Duplicates	in	Google	Sheets	-	COUNTIF	formula	5.	In	“Formatting	style”	select	a	fill	color	for	the	duplicate	cells	or	font	color.	In	this	example,	I	will	select	a	fill	color	in	“Red”.	How	to	Highlight	Duplicates	in	Google	Sheets	-	Fill	in	red	To	apply	the	formatting,	click	“Done”.	All
duplicates	are	now	highlighted	in	the	color	you	selected.	Now	that	you’ve	seen	how	to	highlight	duplicates	in	one	or	various	columns	using	the	Conditional	Formatting	feature	in	Google	Sheets,	let’s	​look	at	how	you	can	achieve	the	same	using	the	=UNIQUE	formula.	You	can	easily	combine	content	from	different	cells	with	the	CONCATENATE
function.	Here's	how	to	use	CONCATENATE	in	Google	Sheets.	READ	MORE	In	the	previous	section,	we	showed	you	how	to	use	the	Conditional	Formatting	built-in	feature	combined	with	the	=COUNTIF	formula.	However,	you	can	use	the	=UNIQUE	formula	directly	in	your	Google	Sheets	file	to	find	and	highlight	duplicates	in	your	worksheet.	1.	Open
your	Google	Sheets	and	type	in	“=UNIQUE”	into	an	empty	cell	next	to	your	data.	You	will	see	how	Google	Sheets	prompts	the	full	formula.	How	to	Highlight	Duplicates	in	Google	Sheets	-	Enter	UNIQUE	2.	You	can	complete	the	formula	by	clicking	the	letter	at	the	top	of	the	column	you	want	to	find	duplicates	in.	Google	Sheets	will	also	include	the
column	range	for	you.	Here,	I	only	want	to	find	duplicates	in	Column	A,	so	my	completed	formula	looks	like	this:	=UNIQUE(A:A).	How	to	Highlight	Duplicates	in	Google	Sheets	-	Select	column	3.	Press	“Enter”	to	apply	the	formula.	It	will	fill	your	column	with	only	the	unique	values	in	your	data	range,	skipping	any	duplicates.	As	you	can	see,	this
column	has	skipped	the	duplicate	data	in	rows	12	and	13.	How	to	Highlight	Duplicates	in	Google	Sheets	-	Enter	You	can	also	apply	this	formula	to	entire	duplicate	rows.	Simply	change	the	formula	to	include	row	numbers,	rather	than	column	letters.	For	example,	to	find	duplicate	rows	in	my	data,	I	simply	type	in	the	following	formula:
=UNIQUE(2:17).	As	you	can	see	below,	the	formula	returns	only	the	unique	rows	of	data	-	it	has	skipped	rows	12	and	13.	How	to	Highlight	Duplicates	in	Google	Sheets	-	Unique	rows	As	the	formula	will	return	entire	values,	adding	them	directly	next	to	your	dataset	may	cause	an	error	message	to	appear.	Instead,	we	recommend	adding	the	formula
directly	below	your	dataset	(as	shown	in	the	example	above),	as	this	will	allow	the	UNIQUE	formula	to	provide	a	full	list	of	all	your	unique	rows.	Now	that	we	know	the	two	main	ways	to	highlight	duplicates	in	Google	Sheets,	let’s	see	how	we	can	quickly	remove	them.	Once	you	have	found	and	highlighted	duplicates	in	one	or	two	columns,	a	row,	or	an
entire	worksheet,	you	can	easily	remove	them	using	the	“Remove	Duplicates”	feature.	1.	Select	the	columns	you	would	like	to	check	and	remove	duplicate	content	for.	Here,	we	will	stick	to	the	same	columns	we	highlighted	in	red.	How	to	Highlight	Duplicates	in	Google	Sheets	-	Select	columns	2.	Go	to	Data	>	Data	cleanup	>	Remove	duplicates.	How
to	Highlight	Duplicates	in	Google	Sheets	-	Remove	duplicates	3.	A	dialogue	box	should	appear	where	you	can	select	the	columns	to	check.	“Select	all”	simply	refers	to	the	column	manually	selected	before,	not	the	whole	dataset.	How	to	Highlight	Duplicates	in	Google	Sheets	-	Columns	to	analyze	4.	If	your	columns	have	a	header	name,	make	sure	to
tick	the	box	“Data	has	header	row”.	Once	finished,	click	“Remove	duplicates”.	How	to	Highlight	Duplicates	in	Google	Sheets	-	Data	has	header	row	5.	Google	Sheets	will	now	show	a	message	informing	you	about	the	number	of	duplicate	rows	removed.	It	also	lets	you	know	how	many	unique	rows	you	have.	Click	“OK”.	How	to	Highlight	Duplicates	in
Google	Sheets	-	Click	OK	This	built-in	feature	is	the	quickest	way	to	remove	duplicates	in	Google	Sheets;	however,	​review	the	content	selected	before	removing,	since	you	may	delete	cells	associated	with	others	in	a	row.How	to	manage	Google	Sheets	data	with	Layer?	Layer	adds	productivity	features	to	your	Google	Sheets.	Share	parts	of	your
spreadsheet,	request	input,	and	accept	or	reject	changes	to	make	collaboration	seamless	and	more	efficient	while	keeping	full	control	over	your	data.	Using	Layer,	you	can:	Manage	Access:	Give	spreadsheet	access	to	relevant	stakeholders	on	a	tab	or	cell	level.Review	&	Track:	Consolidate	input,	and	easily	track	changes.Collaborate:	Define,	assign,
and	automate	tasks	and	set	deadlines.	Sign	up	for	early	access	and	start	automating	your	Google	Sheets	workflows	with	Layer!	Highlighting	duplicates	in	Google	Sheets	is	an	extremely	vital	process	many	users	need	to	carry	out	to	make	sure	that	their	datasets	are	as	accurate	as	possible.	Google	Sheets	has	a	fantastic	data	cleanup	feature	that	makes
this	process	quick	and	easy.	By	the	end	of	this	article,	you	should	now	know	how	to	highlight	and	remove	duplicates	in	Google	Sheets	using	built-in	features	and	the	UNIQUE	formula.	Although	these	methods	are	safe	and	quick,	we	always	recommend	reviewing	your	selection	before	removing	any	data	in	your	worksheet.	If	you	would	like	to	know
more	about	Conditional	Formatting	features	and	applications	in	Google	Sheets,	read	our	blog	article	Conditional	Formatting	in	Google	Sheets	(Complete	Guide).	Prefer	to	work	in	Excel?	Take	a	look	at	the	following	articles	you	manage	and	organize	your	data	better:
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